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Der Java Client

Der Java Client

Der Java Client stellt IThnen innerhalb des IP-Netzwerks einen virtuellen Arbeitsplatz
zur Verfiigung. An diesem virtuellen Arbeitsplatz konnen Sie das KVM-Matrixsys-
tem bedienen und konfigurieren.

Die Software ist Bestandteil der Firmware des Gerites und sofort nach der Installa-
tion des KVM-Matrixsystems betriebsbereit.

Systemvoraussetzungen

Der Java Client wird in der Laufzeitumgebung Java Runtime Environment (JRE) inner-
halb Thres Webbrowsers ausgefiihrt.

Voraussetzung fiir den Start des Clients ist die Installation der Laufzeitumgebung in
der Version 1.5.0 oder hoher.

Die Laufzeitumgebung steht auf der Website http://java.sun.com/javase/downloads/ fiir
die Betriebssysteme Windows, Solaris, Linux und Apple OS zum Download bereit.

WICHTIG: Die Open-Source-Implementation OpenJDK der Java-Plattform wird
nicht unterstiitzt.

Unterstiitzte Webbrowser
Folgende Webbrowser wurden erfolgreich mit dem Java Client getestet:

= Internet Explorer 7
= Internet Explorer 8
= Mozilla Firefox 3.6

Unterstiitzte Betriebssysteme
Folgende Betriebssysteme wurden erfolgreich mit dem Java Client getestet:

= Microsoft Windows XP

= Microsoft Windows Vista

= Microsoft Windows 7

= GNU/Linux Ubuntu 10.04
= GNU/Linux Ubuntu 10.10
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Erste Schritte

Erste Schritte

Die grundlegende Bedienung des Java Clients lernen Sie in diesem Kapitel kennen.

HINWEIS: Detaillierte Erlauterungen der Funktionen und Einstellungen erfolgen
in den folgenden Kapiteln dieses Handbuchs.

Start des Java Clients

Der Java Client kann tber einen unterstiitzten Webbrowser eines Computers mit
installierter Laufzeitumgebung Java Runtime Environment gestartet werden.

HINWEIS: Informationen zu den Systemvoraussetzungen des Clients finden Sie
auf Seite 1.

So starten Sie den Java Client:

1. Geben Sie in der Adresszeile die URL https:/[IP-Adresse des Gerdtes] zum Aufruf
der Webapplikation ein.

HINWEIS: Wird die Webapplikation iiber eine ,normale“ http-Verbindung
gestartet, erhalten Sie den Hinweis, dass der Verbindungsaufbau ausschliefllich
uber eine sichere https-Verbindung moglich ist.

Nach 10 Sekunden erfolgt automatisch die Weiterleitung auf die sichere https-
Verbindung.

2. Falls das im KVM-System gespeicherte Zertifikat nicht verifiziert werden kann,
werden Sie zur Authentisierung des Zertifikates aufgefordert. Das standardma-
Rig hinterlegte Zertifikat erkennen Sie an folgenden Merkmalen:

MD5-Fingerabruck:
A4:53:5(C:42:E4:7C:B8:(7:74:1E:40:3F:D7:FE:95:99

SHA1-Fingerabdruck
E1:59:BF:BC:E3:53:B1:56:0F:23:CE:0QE:ED:49:56:CF:98:78:DC:87

3. Klicken Sie oberhalb der Eingabefelder der Login-Maske auf Client starten.
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Erste Schritte

Eine Verbindung zum KVM-Matrixsystem herstellen

Nach dem Start der Software konnen Sie eine Sitzung mit dem KVM-Matrixsystem
starten. Hiernach wird innerhalb des Java Clients der virtuelle Arbeitsplatz darge-
stellt.

Eine Sitzung mit dem KVM-Matrixsystem starten

So starten Sie eine Sitzung mit dem KVM-Matrixsystem:

1.

Geben Sie im Abschnitt Authentifizierung den Benutzernamen und das Kennwort Thres
Benutzerkontos ein.

WICHTIG: Falls Thnen die Zugangsdaten nicht vorliegen, erfragen Sie diese
beim Administrator des Matrixsystems.

. Wihlen Sie im Abschnitt Language/ Sprache die von Thnen gewiinschte Sprache

(Deutsch oder English) der Software.

. Wiébhlen Sie im Abschnitt Keyboard Layout/ Tastatur Layout die Sprachvariante der

Tastatur (Deutsch, American English, British English, French oder Belgian) Thres Arbeits-
platzes aus.

. Optional: Klicken Sie auf Optionen, falls Sie die (s. Seite 26 ff.) Sitzungsein-

stellungen konfigurieren mochten.

. Starten Sie den Verbindungsaufbau (s. Seite 9) durch Klick auf Anmelden.
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Erste Schritte

Das Client-Fenster

Nachdem der Java Client eine Verbindung zum KVM-Matrixsystem aufgebaut hat,
erscheint auf Threm Bildschirm das Client-Fenster:

[ L2) Java-Client [Bedienung aktiv] - 10.1.20.15 Zielrechner: Target £1 mEx]
ind. 720x400/70

Windows Explorer

srt| mBOE | <@ @) 45

In diesem Fenster wird das On-Screen-Display des KVM-Matrixsystems bzw. die
Bildschirmausgabe des aufgeschalteten Zielrechners dargestellt.

HINWEIS: Da die Darstellung des On-Screen-Displays nicht vom KVM-Matrixsys-
tem, sondern durch den Java Client erstellt wird, ist die Anderung der Positio-
nierung und die Synchronisationseinstellung nicht moglich!

Informationen der Titelzeile

|2/ Java-Ctient [Bedienung aktiv] - 10.1.20.15 Zielrechner: Target £1 Lo

In der Titelzeile des Client-Fensters werden neben dem Namen der Software
folgende Informationen angezeigt:

Bedienungsstatus: Ist die Bedienung des Zielrechners innerhalb des Client-
Fensters aktiv, wird in der eckigen Klammer Bedienung aktiv

angezeigt.

Andernfalls wird in der eckigen Klammer Bedienung inaktiv

angezeigt.
IP-Adresse des Die IP-Adresse des KVM-Matrixsystems auf welchem die Sit-
Gerates: zung gestartet wurde, wird zur Ihrer Information angezeigt.
Name des Im Abschnitt Zielrechner wird der Name des aufgeschalteten
Zielrechners: Zielrechners angezeigt.
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Erste Schritte

Informationen der Statuszeile

Ca

Target 1 ind. 720x400/70 sBis| 30fps | @ | @ | @

In der Statuszeile werden folgende Informationen (von links nach rechts) angezeigt:

Belegungssymbol:

Name des
Zielrechners:

Bezeichnung des
Videoprofils:
Datentransferrate:

Bildfrequenz:

»NumLock«-LED

»CapsLock«-LED

»ScrollLock«-LED

Das Symbol zeigt an, ob ein oder mehrere Benutzer auf den
Zielrechner zugreifen.

Name des aufgeschalteten Zielrechners des Matrixsystems

Bezeichnung des Videoprofils, welches dem aufgeschalteten
Zielrechner zugeordnet wurde

Datentransferrate (in Kilobyte pro Sekunde) zwischen dem
Matrixsystem und dem Java Client.

Anzahl der Bildaktualisierungen pro Sekunde die im Client-
Fenster dargestellt werden

Die LED wird hellgriin dargestellt, wenn die Num-Lock-
Funktion auf dem Zielrechner aktiv ist.

Ist die Funktion nicht aktiv, wird die LED dunkelgriin dar-
gestellt.

Die LED wird hellgriin dargestellt, wenn die Feststelltaste auf
dem Zielrechner betatigt wurde.

Ist die Feststelltaste nicht aktiv, wird die LED dunkelgrin
dargestellt.

Die LED wird hellgriin dargestellt, wenn die Scroll-Lock-
Funktion auf dem Zielrechner aktiv ist.

Ist die Funktion nicht aktiv, wird die LED dunkelgriin dar-
gestellt.

HINWEIS: Die Statuszeile kann wahlweise oben oder unten innerhalb des Client-
Fensters angezeigt werden (s. Seite 16).
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Erste Schritte

Auslosen der Maus aus dem Client-Fenster

Ist die Bedienung des On-Screen-Displays des Matrixsystems bzw. des Zielrechners
innerhalb des Client-Fensters aktiv, wird in der eckigen Klammer Bedienung aktiv
angezeigt.

HINWEIS: In diesem Status werden die Tastatureingaben und Mausaktionen am
lokalen Computer direkt an den Zielrechner weitergeleitet.

Die Bedienung des lokalen Computers mit den Eingabegerdten ist erst nach Auslo-
sen der Maus aus dem Client-Fenster moglich.

So l6sen Sie die Maus aus dem Client-Fenster aus:

= Driicken und halten Sie die Tasten Strg+Shift wahrend Sie zusatzlich die
linke Maustaste betatigen.

Verschieben des Fensterausschnittes (Scrollen)

Ist die Bildschirmauflésung des Zielrechners grofler als jene IThres Computers, so
kann nur ein Ausschnitt des Bildschirminhaltes des Zielrechners auf Threm Monitor
angezeigt werden.

Uber die Bildlaufleisten des Client-Fensters oder mit den Schaltflichen im Scrollen-
Bereich des Steuerboards konnen Sie den darzustellenden Ausschnitt auswéahlen.

So wihlen Sie den darzustellenden Ausschnitt mit der Maus:

= Klicken Sie auf die Bildlaufleisten des Client-Fensters zur Auswahl des darzu-
stellenden Ausschnitts.

= Klicken Sie auf die Schaltflachen (s. u.) im Scrollen-Bereich des Steuerboards.
So wihlen Sie den darzustellenden Ausschnitt mit der Tastatur:

1. Stellen Sie sicher, dass das Client-Fenster aktiv und die » Num Lock«-Funktion
ausgeschaltet ist.

2. Halten Sie Strg+ Shift gedriickt, wahrend Sie eine der - y
rechts abgebildeten Navigationstasten (Num-Taste) des e i
numerischen Tastenblocks betétigen:

= Die Tasten 8 (hoch), 6 (rechts), 2 (runter) und 4 (links) “£R- }‘{ ------ >
bewegen den Bildausschnit in kleinen Schritten.

o Die Tasten 9 (rechts oben), 3 (rechts unten), 1 (links < : >
unten) und 7 (links oben) positionieren den Bildaus- | el v 1
schnitt an die entsprechenden Positionen.

o Die Tasten 5 zentriert den Bildausschnitt in der Mitte.

ﬂ
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Erste Schritte

Umschalten zwischen den Zielrechnern

Zwischen den am KVM-Matrixsystem angeschlossenen Zielrechnern kdnnen Sie
wahlweise liber das On-Screen-Display oder iiber das Steuerboard umschalten.

Nahere Erlduterungen zu den jeweiligen Verfahren erhalten Sie in den folgenden
Abschnitten.

Umschaltung liber das Steuerboard

So schalten Sie einen Zielrechner iiber das Steuerboard auf:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).
2. Klicken Sie ggf. auf den Reiter Zielrechner.

3. Verwenden Sie ggf. die Filterfunktion (s. Seite 12), um die Auflistung der Ziel-
rechner einzugrenzen.

4. Wahlen Sie mit der Maus oder den Pfeiltasten der Tastatureinen Zielrechner aus.

5. Fiihren Sie einen Doppelklick aus oder betétigen Sie die Eingabetaste.

TIPP: Klicken Sie im Steuerboard auf die Schaltfliche Last Target (s. Seite 13), um
sich auf den zuletzt aktiven Zielrechner aufzuschalten.

Umschaltung iiber das On-Screen-Display (OSD)

So schalten Sie einen Zielrechner iiber das On-Screen-Display auf:

1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).
2. Klicken Sie auf die Schaltfliche AdonlS.

3. Wéhlen Sie den aufzuschaltenden Zielrechner mit den Pfeiltasten aus.

4. Betdtigen Sie die Eingabetaste.

Wechsel zwischen Zielrechner und lokalem
Computer

Mochten Sie wahrend einer Sitzung auf einem Zielrechner, Tastatur und/oder
Mausaktionen auf Threm lokalen Computer durchfiihren, ist dies ohne Beendigung
der Sitzung oder Aufruf des Steuerboards moglich.

Detaillierte Informationen zu diesem Thema finden Sie im Abschnitt Auslosen der
Maus aus dem Client-Fenster auf Seite 6.
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Erste Schritte

Timeout bei Inaktivitat

Haben Sie wihrend einer aktiven Sitzung innerhalb von 10 Minuten (Standardein-
stellung) keine Tastatur- bzw. Mausaktion durchgefiihrt, wird die Beendigung der
aktiven Sitzung eingeleitet.

Ein Informationsfenster informiert Sie nach Ablauf des Timeouts tiber die bevor-
stehende Beendigung der Sitzung und bietet Ihnen folgende Wahlmoglichkeiten:

= Sitzung beenden: Klicken Sie auf diese Schaltfliche, um die aktive Sitzung sofort zu
beenden.
= Fortsetzen: Klicken Sie auf diese Schaltfliche, um die aktuelle Sitzung fortzusetzen.

TIPP: Uber die Webapplikation Config Panel konnen Sie die Einstellung des Timeouts
dndern. Die entsprechende Einstellung finden Sie auf dem Reiter KVM-Server der
Konfigurationseinstellungen des Matrixswitches.

Einsatz von Hotkeys wahrend einer Sitzung
Innerhalb eines aktivierten Client-Fensters stehen Ihnen die folgenden Hotkeys
wahrend einer Sitzung zur Verfiigung.

Strg+ Shift+ Maustaste Ausl6sen der Maus aus dem aktiven Client-Fenster

Strg+ Shift+Num-Taste In Kombination mit dem Ziffernblock der Tastatur,
konnen Sie innerhalb des Client-Fensters navigieren.

Beenden der aktiven Sitzung

Zum Beenden der aktiven Sitzung haben Sie zwei Moglichkeiten: Sie konnen die
Sitzung liber das Menii des Steuerboards oder durch das Schlieflen des Client-Fens-
ters beenden

So beenden Sie die aktive Sitzung:

= Ist das Steuerboard gedftnet, klicken Sie in diesem auf das Menti Aktion > Sitzung
schlieBen.

= Andernfalls schliefen Sie das Client-Fenster durch einen Klick auf das Schliefien-
Symbol des Fensters.

Beenden der Software

So beenden Sie die Ausfithrung der Software auf Threm Computer:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).

2. Klicken Sie im Ment auf Aktion > Beenden.

8 - G&D UCON-IP-NEO



Verbindungsaufbau

Verbindungsaufbau

Waihrend des Verbindungsaufbaus einer Sitzung erscheint auf Ihrem Bildschirm ein
Fenster, welches Sie iiber den aktuellen Status des Verbindungsaufbaus informiert:

Verbindungsaufbau lauft

Compact @ i
Center access your IT i et

Video-Socket Anmeldung
| 12%

Q CTRL-Kanal : TLSv1SSL_RSA_WITH_3DES_EDE_CBC_SHA
{2 INPUT Kanal: TLSv1SSL_RSA WITH_3DES_EDE_CBC_SHA
"‘g VIDEO-Kanal: keine Verschliisselung

In diesem Fenster werden (von oben nach unten) folgende Informationen angezeigt:

= Fortschrittshalken: Hier konnen Sie den aktuellen Fortschritt des Anmeldevorgangs
erkennen. Die aktuell durchgefithrte Aktion wird iber dem Balken angezeigt.

= Kanal-Verschliisselung: Die verschiedenen Kanile und die angewendeten Ver-
schliisselungen (s. Seite 27) werden angezeigt.

Messung der Bandbreite

Waihrend des Verbindungsaufbaus wird eine Bandbreitenmessung durchgefiihrt.

Der ermittelte Wert der Messung wird anschlieBend im Rahmen der Aufbereitung
und Ubertragung der Videoinformationen angewendet.

TIPP: Klicken Sie wahrend der Bandbreitenmessung auf Erweitert, um eine grafische
Darstellung der aktuellen gemessenen Bandbreite in Form einer Kurve anzuzeigen.

HINWEIS: Die zur Verfiigung stehende Bandbreite innerhalb eines IP-Netzwerkes
kann sich — je nach Auslastung des Netzwerkes — dndern. Dies kann zu einem
Performanceverlust fithren.

Fihren Sie ggf. eine erneute Bandbreitenmessung (s. Seite 28) wahrend der Sit-
zung durch, falls Sie einen Performanceverlust feststellen.
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Verbindungsaufbau

Chat-Funktion

Der Java Client kann auf mehreren Computern innerhalb des IP-Netzwerkes
installiert werden.

HINWEIS: Zur gleichen Zeit kann immer nur ein Benutzer auf einen IP-Arbeits-
platz des Systems zugreifen.

Die Chat-Funktion des Clients ermoglicht dem Benutzer, der sich am System
anmeldet, mit einem bereits angemeldeten Benutzer in Kontakt zu treten.

Beide Benutzer konnen innerhalb des Chats die weitere Vorgehensweise abstimmen.

So stimmen Sie die weitere Vorgehensweise bei bereits belegter Konsole inner-
halb eines Chats ab:

1. Starten Sie den Verbindungsaufbau (s. Seite 3).

HINWEIS: Auf Threm Bildschirm erscheint ein Hinweis-Fenster, das tiber die
Belegung der des IP-Arbeitsplatzes informiert und eine Verbindungsaufnahme
mit dem anderen Benutzer anbietet.

2. Klicken Sie im Fenster auf Ja, um das Chat-Fenster zu 6ffnen.

WICHTIG: Wird innerhalb des Zeitfensters von 10 Sekunden keine Schaltfliche
angeklickt, wird der Verbindungsaufbau automatisch abgebrochen.

HINWEIS: Wird der Verbindungsaufbau durch Klick auf Nein abgebrochen,
wird wieder das Anmeldung-Fenster angezeigt.

3. Das Chat-Fenster wird auf Ihrem und dem Bildschirm des anderen Benutzers
angezeigt.

HINWEIS: Gibt der andere Benutzer nicht innerhalb von 45 Sekunden eine
Nachricht in das Textfenster ein oder klickt auf Ablehnen oder Sitzung beenden
wird seine Sitzung automatisch beendet und Ihre Sitzung hergestellt.

4. Geben Sie Ihre Nachricht in das Eingabefeld ein und klicken Sie auf Senden oder
betdtigen Sie die Eingabetaste, um Ihre Nachricht an den anderen Benutzer zu
versenden.

5. Die Anwort des anderen Benutzers wird im Textfeld im oberen Bereich des Fens-
ters angezeigt. Hierauf konnen Sie erneut, wie in Schritt 4. erlautert, antworten.

Die Chat-Kommunikation wird beendet, wenn der andere Benutzer Ihren Ver-
bindungswunsch ablehnt bzw. zustimmt oder Sie den Anmeldevorgang durch Klick
auf Sitzung beenden abbrechen.
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Das Steuerboard

Das Steuerboard

|2 Steuerboard
Aktion Zielrechner Video System Ansicht Hilfe
Zielrechner
Adon
Zielrechner | Macros Scrollen
J | Zielrechner | Phys. Adr, |Statug| Zugrifl Komrmental
&l CPU-ID 0000032 CPUAD 0000032 An Zugrift & |.a A
&l CPU-ID 000003F CPU-D 000003F An Zugrift
&l CPU-ID 0000105 CPUAD 0000105 Aus  Zugriff ‘ e ’
Bl CPU-D 0000110 CPU-D 0000110 Aus  Zugrifl E
&l CPU-ID 0000128 CPUAD 0000128 Aus  Zugriff
Bl CPU-D 000124F CPU-D 0D00124F  Aus  Zugriff W w | Y
8l CPU-ID 0001352 CPUAD 0001352 Aus  Zugriff
8l CPU-ID 0001554 CPUAD 0001554 Aus  Zugriff
8l CPU-ID 0001562 CPUAD 0001562 Aus  Zugriff Link Status
8l CPU-ID 0001686 CPU-D 0001685 Aus  Zugriff
&) CPU-ID 0007698 CPUAD DO0MB93  Aus  Fugrif 0
8l CPU-ID 0001698 CPU-D 0001638 Aus  Zugriff
ind. 720x400@70 1.02 KBis 21fps

Das Steuerboard ist die Bedienzentrale des Java Clients. Alle wichtigen Pro-
grammfunktionen sind iiber das Steuerboard erreichbar:

= Umschaltung zwischen den verfiigbaren Zielrechnern

= Aufruf des On-Screen-Displays des Matrixsystems

= Ausfithrung von Tastatur-Makros

= Scrollen des sichtbaren Bildschirminhalts im Client-Fenster der Software

= Auswabhl des darzustellenden Bildschirm-Ausschnittes des Zielrechners

Die Benutzeroberflache

Auf der Benutzeroberfliche stehen Thnen die nachfolgend aufgefithrten Status-
Anzeigen und Werkzeuge zur Verfliigung.

Status-Anzeige der Link-Verbindung

Im Feld Link Status wird der aktuelle Status der seriellen Verbindung (i s
zwischen dem Java Client und dem KVM-Matrixsystem angezeigt. a

HINWEIS: Uber die Link-Verbindung werden die im On-Screen-Display darzu-
stellenden Informationen und die Schaltzustinde der Zielrechner an die Software
Ubermittelt.
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Das Steuerboard

“ Link-Verbindung korrekt hergestellt.
.]||. Link-Verbindung gestort.
Meniileiste

|Aktion  Bearbeiten Zielrechner Yideo System Ansicht Hife |

Die Meniileiste zeigt die aktuell verfiigbaren Befehle an (Aktion, Zielrechner oder
Makros, Video, System, Ansicht, Hilfe).

HINWEIS: Abhingig von der aktivierten Karteikarte des Steuerboards wird entwe-
der der Mentieintrag Zielrechner oder Makro angezeigt.

Filterfunktion

Mit der Filterfunktion oberhalb der Auflistung der Zielrechner kdnnen Sie die
Anzeige der Zielrechner eingrenzen.

So grenzen Sie die Auflistung der Zielrechner mit der Filterfunktion ein:
1. Geben Sie im Textfeld eine beliebige Zeichenkette ein.

2. Auf dem Karteireiter Zielrechner werden daraufhin ausschlieflich solche Rechner
angezeigt, die die eingegebene Zeichenkette in der Spalte Zielrechner, Physikalische
Adresse oder Kommentar enthalten.

Die Grof3-/Kleinschreibung der Namen wird bei der Filterung ignoriert.

3. Um die Filterung aufzuheben, klicken Sie auf Léschen.
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Das Steuerboard

Aufschaltung auf den zuletzt aktiven Zielrechner (Last Target)

Mit der Last Target-Funktion schalten Sie vom derzeit aktiven Zielrechner auf
den zuletzt aufgeschalteten Zielrechner um. §

HINWEIS: Wurde seit dem Start des Java Clients noch kein Zielrechner aufgeschal-
tet oder ausschliefllich auf dem aktuell aufgeschalteten Zielrechner gearbeitet,
steht diese Funktion nicht zur Verfiigung.

So schalten Sie die Verbindung auf den zuletzt aufgeschalteten Zielrechner um:

1. Klicken Sie auf das Last Target-Symbol neben dem Filterfeld.

Verschieben des Fensterausschnittes (Scrollen)

Ist die Bildschirmauflésung des Zielrechners grofier als jene IThres Computers, so
kann nur ein Ausschnitt des Bildschirminhaltes des Zielrechners auf IThrem Monitor
angezeigt werden.

Uber die Schaltflichen im Scrollen-Bereich des Steuerboards konnen Sie den darzu-
stellenden Ausschnitt auswahlen. Weiterfithrende Informationen finden Sie im
Abschnitt Verschieben des Fensterausschnittes (Scrollen) auf Seite 6.

Informationen der Statuszeile

In der Statuszeile werden folgende Informationen (von links nach rechts) angezeigt:

ind. 720x400/70 5Bis| 30fps | @ | @ | @
Bezeichnung des Bezeichnung des Videoprofils, welches dem aufgeschalteten
Videoprofils: Zielrechner zugeordnet wurde
Datentransferrate: Datentransferrate (in Kilobyte pro Sekunde) zwischen dem

Matrixsystem und dem Java Client

Bildfrequenz: Anzahl der Bildaktualisierungen pro Sekunde die im Client-
Fenster dargestellt werden

Karteikarten des Steuerboards

Den grofiten Teil des Steuerboards nehmen die Karteikarten in der Mitte des Fensters
ein. Hier konnen Sie wahlweise die Karteikarten Zielrechner oder Makros anzeigen:

= Die Karteikarte Zielrechner enthdlt eine Auflistung der angeschlossenen Zielrechner.
Zu jedem Zielrechner werden folgende Informationen angezeigt:
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Das Steuerboard

Zielrechner: Bezeichnung des Zielrechners im Matrixsystem
Phys. Adr.: physikalische Adresse des Zielrechners

Status: Schaltzustand (47 oder Aus) des Zielrechners
Zugriff: Zugriffsberechtigung auf den Zielrechner
Kommentar: vom Anwender erfasster Zielrechner-Kommentar

Die Symbole vor den Bezeichnungen der Zielrechner haben folgende Bedeutung:
{7 Siesind auf diesen Zielrechner aufgeschaltet.
 FEin anderer Benutzer ist auf diesen Zielrechner aufgeschaltet.

& Mehrere Benutzer sind auf diesen Zielrechner aufgeschaltet.

&l Der Zielrechner ist eingeschaltet ist (griiner Punkt).

&l Der Zielrechner ist ausgeschaltet (roter Punkt).

= Die Karteikarte Makros ermoglicht das Ausfithren von Tastaturmakros (s. Seite 22).

TIPP: Die anzuzeigenden Tastaturmakros kénnen Sie durch die Auswahl einer
Gruppe (s. Seite 22) filtern.

Darstellungsoptionen der Eintrage der Karteikarten

Die Auflistung der Zielrechner bzw. Makros der Karteikarten konnen in folgenden
Anzeigemodi betrachtet werden:

= Liste: Anzeige kleiner Symbole und Angabe des Namens (nebeneinander)

= Details: Anzeige kleiner Symbole, Angabe des Namens sowie weiterer Informa-
tionen in Tabellenform

So dndern Sie den Anzeigemodi zur Darstellung der Zielrechner bzw. Makros:
1. Offnen Sie ggf. das Steuerboard der Software.

2. Offnen Sie das Ansicht-Menii.

3. Wiéhlen Sie den Eintrag Liste oder Details des Menis.
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Das Steuerboard

Anzeige des On-Screen-Displays iiber das Steuerboard

Das On-Screen-Display (OSD) des KVM-Matrixsystems kann
jederzeit im Client-Fenster angezeigt werden. Uber das OSD ist die @E
Bedienung und Konfiguration des Systems moglich.

HINWEIS: Da die Darstellung des On-Screen-Displays nicht vom KVM-Matrix-
system, sondern vom Java Client erstellt wird, ist die Anderung der Positionierung
und die Synchronisationseinstellung nicht moglich!

So zeigen Sie das On-Screen-Displays des Matrixsystems im Client-Fenster an:

1. Klicken Sie auf die Schaltfliche AdonlS.

TIPP: Wahrend Threr Arbeit auf einem Zielrechner innerhalb des Client-Fensters
konnen Sie das OSD durch Verwendung der Tastenkombination Strg+Num
(Standard) des Matrixsystems aufrufen.

Durchfiihrbare Aktionen im Steuerboard

Steuerboard schlieBen

Schliefen Sie das Steuerboard, um die Arbeit im Client-Fenster der Software fortzu-
setzen.

So schlieffen Sie das Steuerboard:

1. Klicken Sie im Ment auf Aktion > Steuerboard schliefien.

Sitzung schlie3en

Beenden Sie die Sitzung mit dem KVM-Matrixsystem nach Abschluss Ihrer Arbeiten
oder um beispielsweise einem anderen Benutzer die Verwendung des IP-Arbeitsplatz-
platzes zu ermdglichen.

So schliefen Sie die Sitzung:

1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).
2. Klicken Sie im Ment auf Aktion > Sitzung schliefien.

Software beenden

So beenden Sie die Ausfithrung der Software auf Threm Computer:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).

2. Klicken Sie im Ment auf Aktion > Beenden.
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Umschaltung auf Vollbild-Modus des Client-Fensters

Ist auf dem Zielrechner und auf Threm lokalen Computer die gleiche Bildschirmauf-
16sung eingestellt, empfiehlt sich die Darstellung des Client-Fensters im Vollbild-
Modus.

In diesem Modus wird das Client-Fenster auf die vollstdndige Desktopgrofie erwei-
tert, damit der komplette Bildschirm fiir das Bild des Zielrechners zur Verfiigung
steht.

HINWEIS: Taskleisten und andere Bedienelemente auf Ihrem Desktop werden
durch den Vollbild-Modus des Client-Fensters tiberdeckt.

Im Vollbild-Modus ist das Scrollen innerhalb des Client-Fensters nicht erforderlich.

So schalten Sie das Client-Fenster in den Vollbild-Modus:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).
2. Klicken Sie im Ment auf Video > Vollbild oder betatigen Sie die F11-Taste.

Position der Statuszeile festlegen

Die Statuszeile des Client-Fensters kann wahlweise am oberen (Standard) oder am
unteren Fensterrand angezeigt werden.

So bestimmen Sie die Position der Statuszeile des Client-Fenster:
1. Offnen Sie ggf. das Steuerboard der Software.

2. Klicken Sie im Menii auf Ansicht > Statuszeile > Oberer Fensterrand oder alternativ
Ansicht > Statuszeile > Unterer Fensterrand.
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Videoeinstellungen

Beim ersten Aufschalten auf einen Zielrechner wird ein Videoprofil fiir diesen
Rechner erstellt und gespeichert.

Jedes Videoprofil hat eine individuelle Bezeichnung. Der Grundaufbau der von der
Software erstellten und vom Benutzer editierbaren Bezeichnungen hat folgende Syntax:

= [Bildpunkte_horizontal] x [Bildpunkte_vertikal]@[Wiederholfrequenz_vertikal]

HINWEIS: Videoprofilen, die im Rahmen der ersten Aufschaltung auf einen Ziel-
rechner — ohne Ermittlung der Farbwerte — erstellt wurden, wird die Zeichenfolge
Auto- vorangestellt.

Wurde ein Videoprofil im Rahmen des Erstinbetriebnahmemodus der Software IP-
Console Client bzw. mit der Funktion Videoprofil erstellen erstellt, wird diesem die
Zeichenfolge EIM- vorangestellt.

Anzeige der Detailinformationen

So rufen Sie die Einstellungen des aktuellen Videoprofils auf:

1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).

2. Klicken Sie in der Meniileiste auf Video > Videoeinstellungen > Aktuelles Profil bear-
beiten.

Anderung eines Videoprofils

Alle Daten des Videoprofils (Bildlage, die Phasenverschiebung und die Farbwerte)
konnen durch den Benutzer editiert und angepasst werden.

So dndern Sie die Einstellungen des aktuellen Videoprofils:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).

2. Klicken Sie in der Meniileiste auf Video > Videoeinstellungen > Aktuelles Profil bear-
beiten.

3. Andern Sie die gewiinschte(n) Einstellung(en) des Videoprofils (s. Seite 18 f.).

4. Klicken Sie auf Speichern, um die Einstellungen zu speichern oder verwerfen Sie
Thre Eingaben durch Klick auf Abbrechen.
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Einstellungsoptionen

Die Videoeinstellungen des Profils kénnen vom Benutzer editiert werden. Auf den
folgenden Seiten werden die moglichen Einstellungen der verschiedenen Karteikarten
des Fensters erldutert.

Der untere Bereich des Fensters ist auf allen Karteikarten identisch:

[v] direkt anzeigen | Neu zeich... || Abbrechen |

112.18 K... 59 fps SchlieRen || Speichern || Riickgingig |

Links unten wird die die Datentransferrate (in Kilobyte pro Sekunde) zwischen dem
KVM-Matrixsystem und dem Java Client sowie die Anzahl der Bildaktualisierungen
pro Sekunde im Client-Fenster (Bildfrequenz) angezeigt.

Zusatzlich finden Sie hier folgende Bedienelemente:

direkt anzeigen:  Anderungen an den Einstellungen werden sofort auf die Bildan-
zeige im Client-Fenster angewendet

Testen: Anderungen an den Einstellungen auf die Bildanzeige im Client-
Fenster anwenden

Neu zeichnen: Synchronisierung des iibertragenen Bildes des Zielrechners

Abbrechen: Anderungen an den Einstellungen verwerfen und Dialog schlieRen

SchlieBen: Temporare Speicherung der Einstellungen bis zum erneuten
Aufschalten des Zielrechners

Speichern: Speicherung der Einstellungen

Riickgéngig: Anderungen seit dem letzten Speichern verwerfen

Bestimmen von Bildbreite, -lage und -gréBe

Auf der Karteikarte Bild haben Sie die Moglichkeit, die Bildbreite, -lage und -grofie
festzulegen.

TIPP: Mochten Sie die auf dieser Karteikarte editierbaren Einstellungen automa-
tisch ermitteln lassen, klicken Sie auf Bildlageerkennung.

Folgende Voraussetzungen sind zur verldsslichen Ausfithrung der Funktion
erforderlich:

= Die Bildschirmauflosung des Zielrechners ist kleiner als jene des Client-Fensters.

» Die Einstellung der Rénder des aktuell aufgeschalteten Zielrechners liegen inner-
halb einer errechneten Grofle (abhdngig von der jeweiligen Bildauflosung).
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Folgende Einstellungen kénnen von IThnen individuell optimiert werden:

Bildbreite:

Vertikale
Bildlage:

Vertikale
BildgrdBe:

Horizontale
Bildlage:

Horizontale
BildgrdBe:

Breite des Bildes (inkl. der Schwarzschulter) in Pixel

Die Bildbreite ist immer grifier als die Breite des tatsdchlich sichtbaren
Bildbereiches!

Pixel (vertikal) ab welchem das Bild beginnt

Hohe des sichtbaren Bildbereiches

Bei der Einstellung der Bildhohe konnen Sie sich an den iiblichen Bild-
schirmauflosungen orientieren (z. B. 1024 X 768).

Stellen Sie die Bildhohe so ein, dass oben kein schwarzer Rand verbleibt
und das Bild vollstindig sichtbar ist.

Pixel (horizontal) ab welchem das Bild beginnt

Breite des sichtbaren Bildbereiches

Bei der Einstellung der Bildbreite kénnen Sie sich an den tiblichen Bild-
schirmauflosungen orientieren (z. B. 1024 X 768).

Stellen Sie die Bildlage so ein, dass links kein schwarzer Rand verbleibt
und das Bild vollstindig sichtbar ist.

So dndern Sie die vorbelegten Werte:

1. Andern Sie die gewiinschten Werte in den verschiedenen Eingabefeldern.

Hierbei ist es empfehlenswert, die numerischen Werte nicht direkt tiber die
Tastatur einzugeben, sondern die Pfeiltasten zu verwenden.

TIPP: Haben Sie die Funktion direkt anzeigen (s. Seite 18) aktiviert, kdnnen Sie
die Einstellungen komfortabel dndern und gleichzeitig die Auswirkung im
Client-Fenster betrachten.

HINWEIS: Klicken Sie auf Riickgadngig, um die urspriinglichen Werte dieses Rei-
ters wieder zu aktivieren.
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Bestimmen der Farbwerte

Auf der Karteikarte Farben konnen Sie die Farbwerte und die Helligkeit des Bildes
individuell einstellen.

TIPP: Mochten Sie die auf dieser Karteikarte editierbaren Einstellungen automa-
tisch ermitteln lassen, klicken Sie auf Auto-Farbeinstellung.

Folgende Einstellungen kdnnen von Thnen individuell optimiert werden:

Rot: Einstellung des Farbwertes der Farbe rot

Griin: Einstellung des Farbwertes der Farbe griin

Blau: Einstellung des Farbwertes der Farbe blau

Farbregler Aktivieren Sie diese Option, wenn Sie den Kontrast anpassen
synchronisieren:  mgchten. Bei der Anderung eines Farbwertes werden die

Werte der beiden anderen Farben ebenfalls angepasst.

Ist die Funktion deaktiviert (Standard) konnen Sie die Gewich-
tung der einzelnen Farben verdndern, beispielsweise um einen
Farbstich im Bild zu korrigieren.

Helligkeit: Einstellung der Grundhelligkeit des Bildes

So dndern Sie die vorbelegten Werte:
1. Verwenden Sie die Schieberegler, um die Farbwerte und die Helligkeit einzustellen.

Alternativ konnen Sie die gewilinschten Werte direkt in den entsprechenden
Eingabefeldern erfassen.

TIPP: Haben Sie die Funktion direkt anzeigen (s. Seite 18) aktiviert, kdnnen Sie
die Einstellungen komfortabel dndern und gleichzeitig die Auswirkung im
Client-Fenster betrachten.

HINWEIS: Klicken Sie auf Riickgangig, um die urspriinglichen Werte dieses Rei-
ters wieder zu aktivieren.
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Einstellung der Phasenlage

Die Einstellung der Phasenlage ist eine wesentliche Einstellung fiir die korrekte Ver-
arbeitung des Videosignals.

TIPP: Die Funktion Autophase iibernimmt die Phaseneinstellung fiir den Benutzer.

Zur korrekten Ausfiihrung der Funktion ist die Ausgabe eines statischen Bildes
(beispielsweise des Desktops) durch den Zielrechner erforderlich.

Ist auf dem Zielrechner ein Bildschirmschoner aktiv, kann die Funktion nicht
durchgefiihrt werden!

So dndern Sie die vorbelegte Phaseneinstellung:
1. Wéhlen Sie im Abschnitt Einstellung die Option manuell.

2. Stellen Sie den gewiinschten Wert ein.

TIPP: Zeigen Sie auf dem Zielrechner moglichst ein Bild mit senkrechter
Schraffur oder vielen senkrechten Linien an und optimieren Sie den Phasen-
Wert so, dass die Linien gleichméfig und scharf dargestellt werden.

Hierbei ist es empfehlenswert, die numerischen Werte nicht direkt iiber die
Tastatur einzugeben, sondern die Pfeiltasten zu verwenden.

TIPP: Haben Sie die Funktion direkt anzeigen (s. Seite 18) aktiviert, konnen Sie die
Einstellungen komfortabel d&ndern und gleichzeitig die Auswirkung im Client-
Fenster betrachten.

3. Optional: Aktivieren Sie falls gewilinscht die Option Rauschunterdriickung.

HINWEIS: Klicken Sie auf Riickgadngig, um die urspringlichen Werte dieses Rei-
ters wieder zu aktivieren.
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Tastaturmakros

Viele Benutzer verwenden Tastaturbefehle zur schnellen und effizienten Bedienung
des Betriebssystems oder der Anwendungssoftware.

Bei der Bedienung der Zielrechner iiber den IP-Arbeitsplatz des KVM-Matrixsystems
befinden sich drei Gerdte in der Kommunikationsstrecke: der Zielrechner, der
Matrixswitch und der lokale Computer auf dem der Java Client betrieben wird.

WICHTIG: Betdtigen Sie eine Tastenkombination (beispielsweise Strg+Alt+Entif),
wird diese vom lokalen Computer interpretiert und somit nicht zum Zielrechner
ubertragen.

Verwenden Sie die in diesem Kapitel beschriebenen Tastaturmakros des Steuer-
boards, um die Weiterleitung der Tastenkombinationen an den Zielrechner sicher-
zustellen.

Ausfiihren eines Tastaturmakros

Die Tastaturmakros kdnnen wahlweise iiber das Steuerboard oder mit den — in den
Einstellungen der Tastaturmakros — gewéhlten Tastenkombinationen ausgefithrt
werden.

So fiihren Sie ein Tastaturmakro iiber das Steuerboard aus:

1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).
2. Klicken Sie ggf. auf den Reiter Makros.

3. Doppelklicken Sie auf das auszufithrende Makro.

Filterung der Makros anhand einer Gruppe

Um auch bei einer Vielzahl von Makros schnell das gewiinschte Makro zu finden,
konnen die einzelnen Makros in Gruppen organisiert werden.

HINWEIS: In der Standardkonfiguration sind die Gruppen Linux, Novell, G&D Hot-
keys, SUN, VMWare, Windows und special keys angelegt.

So grenzen Sie die auf dem Reiter Makros anzuzeigenden Tastaturmakros ein:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).
2. Klicken Sie ggf. auf den Reiter Makros.

3. Wiéhlen Sie im Feld Makro-Gruppe die Gruppe aus, deren Makros aufgelistet wer-
den sollen.
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Videofunktionen

Automatische GréBenanpassung des Client-Fensters (AutoFit)

Die automatische GrofRenanpassung passt die Grofie des Client-Fensters bei jedem
Aufschaltvorgang an die aktuelle Auflosung des Zielrechners an.

TIPP: Fiir einen optimalen Bedienkomfort ist es empfehlenswert, die Auflosung
Thres lokalen Computers hoher einzustellen als die des Zielrechners.

Ist die Bildschirmauflosung des Zielrechners grofier als jene Ihres Computers, so
konnen Sie den anzuzeigenden Bildschirmausschnitt im Client-Fenster verschieben
(s. Seite 6).

So (de)aktivieren Sie die AutoFit-Funktion:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).

2. Klicken Sie in der Meniizeile auf Video > AutoFit.

HINWEIS: Ist die Funktion aktiviert, erscheint neben dem Meniipunkt eine
Markierung.

Erneute Ubertragung des volistindigen Bildschirminhaltes

Mit der Funktion Bild neu zeichnen erreichen Sie eine vollstindige Ubertragung des
gesamten Bildschirminhaltes. Eventuell auftretende Bildartefakte werden durch die
erneute Ubertragung beseitigt.

TIPP: Diese Funktion konnen Sie alternativ mit der F5-Taste aktivieren, wenn das
Steuerboard aktiv ist.

So erreichen Sie die vollstindige Ubertragung und Darstellung des Bildes:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).

2. Klicken Sie in der Meniizeile auf Video > Videoeinstellungen > Bild neu zeichnen.

Erneute Ubertragung und Phasen-Erkennung des Bildes

Mit der Funktion Bild neu synchronisieren erreichen Sie eine vollstindige Ubertragung
des gesamten Bildschirminhaltes sowie die automatische Phasen-Erkennung.

So erreichen Sie die vollstindige Synchronisierung des Bildes:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).

2. Klicken Sie in der Meniizeile auf Video > Videoeinstellungen > Bild neu synchronisieren.
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Automatische Erkennung der Phasenlage

Mit der Funktion Autophase fithren Sie eine automatische Erkennung der Phasenlage
durch.

So fiihren Sie die automatische Phasen-Erkennung durch:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg-+ Shift (Standard).

2. Klicken Sie in der Meniizeile auf Video > Videoeinstellungen > Autophase.

Automatische Bestimmung der Farbwerte

Mit der Funktion Auto-Farbeinstellung wird die automatische Bestimmung der Far-
bwerte des Zielrechners ausgefiihrt.

So fiihren Sie die automatische Bestimmung der Farbwerte durch:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg-+ Shift (Standard).

2. Klicken Sie in der Mentizeile auf Video > Videoeinstellungen > Auto-Farbeinstellung.

Automatische Erkennung der Bildlage

Mit der Funktion Bildlageerkennung wird die automatische Erkennung der Bildlage
des Zielrechners ausgefiihrt.

So fiihren Sie die Erkennung der Bildlage durch:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg-+ Shift (Standard).

2. Klicken Sie in der Meniizeile auf Video > Videoeinstellungen > Bildlageerkennung.
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Mausbremse

Viele Betriebssysteme bieten den Benutzern eine so genannte Mausbeschleunigung an.

HINWEIS: Die Mausbeschleunigung der Betriebssysteme wertet neben der Strecke,
die die Maus verschoben wird, auch die Dauer der Bewegung aus.

Bei ,langen“ Bewegungen wird die Bewegung des Mauszeigers auf dem Bild-
schirm beschleunigt.

Wenn sowohl auf Threm lokalen Computer als auch auf dem Zielrechner eine Maus-
beschleunigung durchgefiihrt wird, hat dies zur Folge, dass sich der Mauszeiger auf
dem Zielrechner sehr schnell bewegt und hierdurch die Bedienung erschwert.

Mausbremse aktivieren

Die Anwendung der Mausbremse kann wahrend der Sitzung tiber das Steuerboard einge-
stellt werden.

So (de)aktivieren Sie die Anwendung der Mausbremse innerhalb einer Sitzung:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).
2. Klicken Sie im Menti auf System > Mausbremse konfigurieren.

3. Aktivieren oder deaktivieren Sie die Optionen Maushremse aktivieren bzw. Maus-
bremse global aktivieren im Abschnitt Aktivierung.

4. Klicken Sie auf 0K, um die Einstellungen anzuwenden oder verwerfen Sie IThre
Eingaben durch Klick auf Abbrechen.

Beschleunigungswert der Mausbremse konfigurieren

So legen Sie den Beschleunigungswert der Mausbremse fest:

1. Schalten Sie sich auf den Zielrechner auf, dessen Beschleunigungswert der Maus-
bremse Sie 4ndern mochten.

2. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).
3. Klicken Sie im Menii auf System > Mausbremse konfigurieren.

4. Stellen Sie den gewiinschten Beschleunigungswert iiber den Regler ein:
HINWEIS: Bewegt sich die Maus auf dem Zielrechner zu schnell, verdndern Sie
den Regler nach links (Langsam). Im umgekehrten Fall bewegen Sie den Regler
nach rechts (Schnell).

5. Klicken Sie auf Speichern, um die Einstellungen zu speichern oder verwerfen Sie
Thre Eingaben durch Klick auf Abbrechen.
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Erweiterte Funktionen

Sitzungseinstellungen

Vor der Herstellung einer Sitzung mit dem KVM-Matrixsystem konnen Sie die
nachfolgend beschriebenen Einstellungen der Sitzung festlegen.

Sprache

Die Benutzeroberfliche des Java Clients unterstiitzt mehrere Sprachen (Deutsch und
English). Wahlen Sie die von Thnen gewlnschte Sprache aus.

Hotkey-Auswahl

Weihlen Sie eine Tastenkombination (Standard: Strg+Shift) zum Aufruf des Steuer-
boards.

Bedienung

Bei IP-basierten KVM-Produkten werden die analogen Tastatur-, Video- und Maus-
Signale digitalisiert und anschlieflend iiber das IP-Netzwerk tibertragen.

Abhéngig von der Auflosung und Farbtiefe des Videosignals vom Zielrechner kann
die zur Verfligung stehende Bandbreite durch ein hoheres Datenaufkommen stark
beansprucht werden.

HINWEIS: Dies kann zu Performanceeinbufen bei schmalbandigen Verbindungen
fithren. Eine mogliche Auswirkung ist beispielsweise, dass fiir das Maus-Signal nur
noch minimale Bandbreite zur Verfiigung steht und eine fliissige Bedienung der
Maus somit erschwert wird.

Um diesen Effekt zu mindern, kdnnen Sie im Bereich Bedienung einstellen, wie die
zur Verfiigung stehende Bandbreite bevorzugt verwendet werden soll.

Drei Einstellmoglichkeiten stehen Thnen zur Verfiigung:

anzeigen und Der Bildschirmaufbau und der Mauszeiger werden gleichrangig
bedienen: behandelt.
Diese Einstellung wird bei Einsatz einer LAN-Verbindung empfohlen
(Standardeinstellung).
anzeigen: Der Bildschirmaufbau wird bevorzugt behandelt.

Diese Einstellung wird empfohlen, wenn bei einer schmalbandigen Ver-
bindung die Aufgabe hauptsichlich im ,, Beobachten* besteht.

bedienen: Der Mauszeiger wird bevorzugt behandelt.

Diese Einstellung wird empfohlen, wenn bei einer schmalbandigen Ver-
bindung die Aufgabe hauptsdichlich in der Administration und Konfigura-
tion der Zielrechner besteht und ein schneller Bildschirmaufbau von
nachrangiger Bedeutung ist.
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Verschliisselung

WICHTIG: Werden sensible Daten auf dem Zielrechner angezeigt und editiert, ist
die Aktivierung der Verschliisselung des Inmput- und des Video-Kanals bei Daten-
ibertragung iiber das Internet empfehlenswert.

Wird der Datenverkehr iiber eine gesicherte VPN-Verbindung geleitet, ist die Ver-
schlisselung uiblicherweise nicht erforderlich.

Die Dateniibertraugung zwischen dem Matrixsystem und der Software kann durch
den Einsatz von Verschliisselungsoptionen gesichert werden.

Wihrend die Ubertragung der Authentifizierungsdaten immer gesichert ist, konnen
Sie die Daten der Tastatur-/Maus-Aktionen und des iibertragenen Videosignals
optional verschlisseln.

HINWEIS: Bedenken Sie, dass jede zusétzliche Verschlisselung Zeit erfordert und
somit die Performance beeinflusst.

Folgende Verschliisselungsoptionen stehen zur Verfiigung:

CTRL-Kanal: Uber diesen Kanal wird der Datenaustausch im Rahmen des
Anmeldevorgangs an das Matrixsystem tibertragen.

Die Datentibertragung dieses Kanals wird immer verschltisselt.

Input-Kanal: Uber diesen Kanal werden die Tastatur-/Maus-Signale zum
Matrixsystem tbertragen.

Wird auf die Verschliisselung dieses Kanals verzichtet, ist das
Abhoren (sniffen) der IP-Pakete moglich.

Die Verschliisselung ist optional und kann geringfiigige Performanceverluste
durch erhohtes Datenaufeommen hervorrufen.

Video-Kanal: Uber diesen Kanal wird das Videosignal des Zielrechners an den
Java Client ibertragen.

Wird auf die Verschliisselung dieses Kanals verzichtet, kann das
ibertragene Bild des Zielrechners durch abgehorte IP-Pakete
wiederhergestellt werden.

Die Verschliisselung ist optional und kann geringfiigige Performanceverluste
durch erhohtes Datenaufeommen hervorrufen.
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Bandbreitenmessung

Die zur Verfiigung stehende Bandbreite innerhalb eines IP-Netzwerkes kann sich — je
nach Auslastung des Netzwerkes — dndern. Dies kann zu einem Performanceverlust
fithren.

Falls Sie einen Performanceverlust feststellen, ist die Durchfithrung einer erneuten
Bandbreitenmessung empfehlenswert.

So fiihren Sie eine erneute Bandbreitenmessung durch:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).

2. Klicken Sie in der Meniizeile auf System > Bandbreitenmessung.

Client-/Serverinformationen anzeigen

Informationen iiber den Java Client und das Matrixsystem (Server) konnen Sie liber
das Hilfe-Menii auslesen.

So zeigen Sie die Client-/Serverinformationen an:
1. Offnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+ Shift (Standard).
2. Klicken Sie im Ment auf Hilfe > Info.

3. Klicken Sie auf Client oder Server, um die entsprechenden Informationen anzu-
zeigen.

4. Klicken auf SchlieBen.

Systemweite Hotkeys im Client-Fenster

Innerhalb eines aktivierten Client-Fensters stehen Thnen die folgenden Hotkeys
wéhrend einer Sitzung zur Verfligung.

Strg-+ Shift+ Maustaste Auslosen der Maus aus dem aktiven Client-Fenster

Strg+ Shift+Num-Taste In Kombination mit einer Taste des Ziffernblocks der
Tastatur konnen Sie innerhalb des Client-Fensters
scrollen.

Weiterfiihrende Informationen finden Sie im
Abschnitt Verschieben des Fensterausschnittes (Scrollen) auf
Seite 13.
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About this guide

This guide is authored with special diligence and verified by the state of the art for
correctness.

G&D neither explicitly nor implicitly takes guarantee or responsibility for the qual-
ity, efficiency and marketability of the product when used for a certain purpose that
differs from the scope of service covered by this guide.

For losses, which directly or indirectly result from the use of the documentation as
well as for incidental damages or subsequent damages, G&D is liable only in the
cases of intent or gross negligence.

Warranty exclusion

In the following cases, G&D will not accept warranty claims:

= The devices were not used as intended.

= The devices were repaired or modified by unauthorized personnel.

= The devices offer extensive external damage that was not reported at time of
delivery.
= The devices were damaged by third-party accessories.

G&D will assume no liability for any consequential damages that may arise from
the use of the products.
Trademark credits

All product and company names mentioned in this guide and other documents you
have received with your G&D product may be trademarks or trade names of their
respective owners.

Impressum

© Guntermann & Drunck GmbH 2010. All rights reserved.

Version 1.00 —14/12/2010
Software: 2.3.001 (00692)

Guntermann & Drunck GmbH
Obere Leimbach 9
57074 Siegen

Germany

Phone +49 271 23872-0
Fax  +49 271 23872-120

http://www.gdsys.de
sales@gdsys.de
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The Java client

The Java client

The Java client provides a virtual console within the IP network. This virtual console
enables the user to operate and configure the KVM matrix system.

The client is part of the device’s software and immediately ready for use after the
KVM matrix system has been installed.

System requirements

The web application is carried out in Java Runtime Environment (JRE).

The start of the web application requires the installation of version 1.5.0 or later.

A free download for Windows, Solaris, Linux and Apple OS is available at
hitp://java.sun.com/javase/downloads/.

IMPORTANT: The OpenJDK open source implementation of the Java platform is not
supported.

Supported web browsers
The following web browsers support the web application:

= Internet Explorer 7
= Internet Explorer 8
= Mozilla Firefox 3.6

Supported operating systems
The following operating systems have been successfully tested with the Java client:

= Microsoft Windows XP

= Microsoft Windows Vista

= Microsoft Windows 7

= GNU/Linux Ubuntu 10.04
= GNU/Linux Ubuntu 10.10
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Getting started

Getting started

This chapter describes the basic operation of the Java client.

NOTE: The following chapters describe all functions and settings in detail. ‘

Starting the Java client

The Java client can be applied on a computer with installed Java Runtime Environment.

NOTE: Information regarding the system requirements of the web application can
be found page 1.

How to start the Java client:

1. Enter the URL https://[device IP address] to the address bar in oreder to call the web
application.

NOTE: If the web application is started via a “simple” http connection, a mes-
sage informs the user that the connection can only be established via a secure
https connection.

After 10 seconds, the user is automatically forwarded to a secure https connection.

2. In case the certificate that is stored in the KVM system cannot be verified, you
are asked to confirm the certificate. The provided certificate contains the follow-
ing features:

MDS5 fingerprint:
A4:53:5C:42:E4:7C:B8:C7:74:1E:40:3F:D7:FE:95:99

SHAI1 fingerprint:
E1:59:BF:BC:E3:53:B1:56:0E:23:CE:QE:ED:49:56:CF:98:78:DC:87

3. Click the Start client button above the login box.

2 - G&D UCON-IP-NEO



Getting started

Establishing a connection to the KVM matrix system

After the client has been started, you can start a session with the KVM matrix system.
The virtual console is now displayed in the Java client.

Starting a session with the KVM matrix system

How to start a session with the KVM matrix system:

1. Use the Authentication paragraph to enter your Username and your Password.

IMPORTANT: Ask the administrator of the KVM matrix system if you are not
familiar with the access data to the system.

2. Use the Language/Sprache paragraph to select your language (Deutsch or English)
(Deutsch oder English).

3. Use the Keyboard Layout/ Tastatur Layout paragraph to select the keyboard layout
(Deutsch, American English, British English, French or Belgian) of your console.

4. Optional: Click on Options, if you want to configure the session settings (see
page 26 ff.).

5. Start the connection (see page 9) by clicking Login.
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The client window

After the Java client has established a connection to the KVM matrix system, the cli-
ent window is displayed on your monitor:

L/ JavaClient [active] - 10.1.20.15 Target: Target #1 BEx]

ind. 720x400,70
E’-

Windows Explorer

fsrt| mBOE | «B @) w45

This window displays the on-screen display of the KVM matrix system or the moni-
tor image of the accessing target.

NOTE: Since the image of the on-screen display is not created by the KVM matrix
system but by the Java client, its position or the synchronisation settings cannot be
changed!

Information in the header

|12 Java-Client [active] - 10.1.20.15 Target: Target #1 M=%

The header of the client window displays the software name and the following infor-
mation:

Operating status: If the target can be operated in the client window, the square
brackets display active operation.

Otherwise the square brackets display inactive operation.

Device IP address: The IP address of the KVM matrix system on which the ses-
sion has been started is displayed for your information.

Target name The Target part displays the name of the accessing target.
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Information in the status bar

Ca

Target 1 ind. 720x400/70 sBis| 30fps | @ | @ | @

The status bar shows the following information (from left to right):

Status symbol:

Target name:
Video profile name:

Image frequency:

Data transfer rate:

»NumLock« LED

»CapsLock« LED

»ScrollLock« LED

The symbol indicates if one or several users are accessing the
target.

Name of the accessing KVM matrix system target.

Name of the video profile which is assigned to the accessing
target.

Number of image updates per second that are displayed in
the client window.

Data transfer rate (in kilobyte per second) between KVM
matrix system and Java client.

The LED is displayed in light green if the Num-Lock function
is activated on the target.

If this function is disabled, the LED is displayed in dark
green.

The LED is displayed in light green if the CapsLock key is
activated on the target.

If the CapsLock key is not activated, the LED is displayed in
dark green.

The LED is displayed in light green if the Scroll-Lock function
is activated on the target.

If this function is disabled, the LED is displayed in dark
green.

NOTE: The status bar can either be displayed above or below the client window

(see page 16).
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Releasing the mouse from the client window

If the on-screen display of either the KVM matrix system or the target can be oper-
ated in the client window, the square brackets display active operation.

NOTE: In this status, all keyboard entries and mouse activities at the local compu-
ter are directly transmitted to the target.

The local computer can only be operated via input devices after the mouse has been
released from the client window.

How to release the mouse from the client window:

= Press and hold the keys Ctrl+Shift while additionally pressing the left mouse key.

Scrolling an image section

If the screen resolution of the target is higher than the resolution on your computer,
only a section of the target’s screen content can be displayed on your monitor.

Use the scrollbars of the client window or the buttons in the Scroll area of the control
panel to select the section to be displayed.

How to select the section to be displayed by mouse:

= Click the scrollbars of the client window to select the section to be displayed.
= Click the buttons (see below) in the Scroll area of the control panel.

How to select the section to be displayed by keyboard:

1. Make sure the client window is activated and the » Num Lock« function is disa-
bled.

2. Press Cirl+Shift in combination with one of the navigation r~ Ty
keys (Num key) of the numerical keyblock: ki ;

o The keys 8 (up), 6 (right), 2 (down) and 4 (left) move the
image section in small steps. < }‘{ ------ >
o The keys 9 (top right), 3 (bottom right), 1 (bottom down)
and 7 (top left) put the image section to the respective ;
positions. el v bl |

@ The 5 key centres the image section in the middle.

«_|
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Switching between targets

You can switch between the targets that are connected to the KVM matrix system
by using the on-screen display or the control panel.

The following paragraphs provide a detailed description of each mode.
Accessing a target with the control panel
How to access a target with the control panel:

1. Open the control panel with the key combination Ctrl+ Shift (default).
. Click the Targettab.

2
3. If necessary, use the filter function (see page 12), to limit the list of the targets.
4. Use mouse or the arrow keys to select a target.

5

. Double-click the target or press Enter.

ADVICE: Click the Last Target button (see page 13) to access the last active target.

Accessing a target via OSD

How to access a target using the on-screen display:

1. Open the control panel with the key combination Ctrl+Shift (default).
2. Click the AdonlS.

3. Use the arrow keys to select the target to be accessed.

4. Press Enter.

Switching between target and local computer

If keyboard and/or mouse activities are to be executed on your local computer dur-
ing a session on a target, you do not have to close your session or call the control
panel.

The paragraph Releasing the mouse from the client window on page 6 provides detailed
information regarding this topic.
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Timeout during inactivity

If no keyboard or mouse activities are carried out during a time span of 10 minutes
(default), the active session is about to be cancelled.

An window informs you that the active session is about to be cancelled and offers
the following possibilities:

= Exit session: Click this button to close the current session immediately.

= Continue: Click this button to continue with the current session.

ADVICE: Use the Config Panel web application to change the timeout settings. This
particular setting can be found on the KVM Server tab in the configuration settings
of the matrix switch.

Using hotkeys during a session

During your session, the following hotkeys are provided to be used in the active client
window.

Ctrl+ Shift+Mouse key releases the mouse from the active client window

Ctrl+ Shift+Num key Use this key combination in combination with the key-
board’s numeric pad to navigate in the client window.

Closing the current session

There are two possibilities to close the current session: You can use the control
panel to close the session or simply close the client window.

How to close the current session:

= If the control panel is open, click the menu Action > Exit session.
= You can also close the client window by clicking the window’s Close symbol.

Closing the Java client

How to close the Java client at your computer:
1. Open the control panel with the key combination Cirl+Shift (default).

2. Use the menu bar to click on Action > Exit application.
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Establishing a connection

When establishing a connection, a window opens on your screen. This window
informs you about the current status of the connection establishment:

Connection active

Compact @ i
Center access your IT i et

Video-Socket connection
| 12% |

Q CTRL-Channel : TLSv1SSL_RSA_WITH_3DES_EDE_CBC_SHA
{8 INPUT-Channel: TLSvISSL_RSA_WITH_3DES_EDE_CBC_SHA
“I= VIDEO-Channel: not encrypted

This window displays the following information (from top to bottom):

= Progress bar: Here, you can see the current progress of the login procedure. The cur-
rently executed activity is displayed above the bar.

= Channel encryption: The different channels and the applied encryptions (see page 27)
are displayed.

Detecting the average bandwidth
The bandwidth is detected while the connection is being established.

Now, the detected value is being applied to edit and transmit the video information.

ADVICE: Click on Advanced while the bandwidth is being detected to display the cur-
rently detected bandwidth in the form of a curve.

NOTE: The provided bandwidth within an IP network can vary depending on the
network load. This might lead to performance losses.

If necessary, re-execute the bandwidth recognition during the session (see
page 27) if you notice performance losses.
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Chat function

The Java client can be installed on several computers in the IP network.
NOTE: Only one user can access the IP console at the same time.

The client’s chat function enables the user who logs in to the system to contact an
already logged-in user.

Both users can use the chat to agree on the further procedure.

How to use the chat to agree on the further procedure if the console is already
occupied:

1. Establish a connection (see page 3).

NOTE: Your screen now displays a window which informs you that the IP con-
sole is currently occupied and offers to contact the other user.

2. Click Yes to open the chat window.

IMPORTANT: If no button is clicked within 10 seconds, the connection estab-
lishment is cancelled.

NOTE: If the connection cannot be established because the progcess was can-
celled by clicking No, the login mask is displayed again.

3. The chat window is displayed on your screen and on the screen of the other user.

NOTE: If the other user does not answer within 45 seconds or clicks on Deny or Exit
session, /is session is automatically being cancelled and your session is being
established.

4. Enter your message in the input field and click Send or press Enter to send your
message to the other user.

5. The other user’s message is displayed in the text field in the upper section of the
window. You can answer this message as described in step 4.

The chat is closed if the other user denies or accepts your request or if you cancel the
login procedure by clicking Exit session.
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Control panel

%) control panel
Action Target Video System View Help
Target
Adon5-
Target Macros Scrolling
JJ Target | Phys. Addr. |Statug| Access| Comment
&1 CPUAD 0000032 CPU-D 0000032 On  Access & |.a A
&1 CPUAD 000003F CPU-D D00003F On  Access
i CPUAD 0000105 CPU-D 0000105 Off  Access ‘ e ’
&l CPUAD 0000110 CPUHD 0000110 Off  Access B3
i CPUAD 0000128 CPUAD 0000128 Off  Access
B CPUAD 000124F CPUAD DOM24F  OF  Access W w | Y
&l CPUAD 0001352 CPUAD 0001352 Off  Access
&l CPUAD 0001554 CPU-D 0001554 Off  Access
8l CPUAD 0001562 CPU-D 0001562 Off  Access Link status
8l CPUAD 0001686 CPU-D 0001686 Off  Access
&) CPUAD DODIE3E CPUD DODTES8  OF  Access 0
&l CPUAD 0001698 CPU-ID 0001638 Off __Access
ind. 720x400@70 1.02 KBis 21fps

The control panel is the operating centre of the Java client. All important functions can
be accessed via the control panel:

= switching between the available targets

= calling the on-screen display of the KVM matrix system

= executing keyboard macros

= scrolling the visible screen contents in the software’s client window
= selecting the image sections to be displayed

The user interface

The user interface provides you with the status displays and tools listed in the fol-
lowing paragraph.

Status display of the connection

The Link Status field displays the current status of the serial connection s
between the Java client and the KVM matrix system. a

NOTE: The connection transmits the information and switching states to be dis-
played on the on-screen display to the client.
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“ The connection has been properly established.
.]||. The connection is interrupted.
Menu bar

|.ﬁ.|:l:i|:|r| Edit Target Wideo Svystem iew Help|

The menu bar displays the commands that are currently available (Action, Target or
Macros, Video, System, View, Help).

NOTE: Depending on the activated tab of the control panel, either the Target or
Macro menu item is displayed.

Filter function

The filter function above the list of the target enables you to limit the displayed targets.

How to limit the list of displayed targets by using the filter function:
1. Enter any string to the text field.

2. The Target tab only displays the computers that contain the entered string in the
Target, Physical address or Comment column.

3. Click Delete to discard the filtering.
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Accessing the last target (Last Target)

The Last Target function enables you to access the last active target from the cur-
rently active target.

NOTE: If you accessed no target since the start of the Java client or you only worked
on the currently accessing target, this function is not provided.

How to access the last active target:

1. Click the Last Target symbol next to the filter field.

Scrolling the image section

If the screen resolution of the target is higher than the resolution on your computer,
only a section of the target’s screen content can be displayed on your monitor.

You can use the buttons in the Scroll area of the control panel to select the section to
be displayed. Further information regarding this topic are provided in the paragraph
Scrolling an image section on page 6.

Information in the status bar
The status bar provides the following information (from left to right):

ind. 720x400/70 5Bis| 30fps | @ | @ | @

Video profile name:  Name of the video profile which is assigned to the accessing
target

Image frequency: Number of image updates per second that are displayed in
the client window

Data transfer rate: Data transfer rate (in kilobyte per second) between KVM
matrix system and the Java client.

Control panel tabs

The tabs in the middle of the window take the biggest part of the control panel. Here,
you can display the Targets or Macros tabs:

= The Target tab contains a list of the connected targets.
For each target, the following information is displayed:

Target: target name in the KVM matrix system
Phys. Addr.: the target’s physical address

Status: the target’s switching status (on or off)
Access: access right for the target

Comment: user comment regarding the target
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The symbols that are put in front of the target names have the following meaning:

& Youare accessing this target.

" Another user is accessing this target.
& Several users are accessing the target.
&' The target is switched on (green spot).

&l The target is switched off (red spot).

= The Macros tab enables you to execute keyboard macros (see page 22).

ADVICE: The keyboard macros to be displayed can be filtered by selecting a
group (see page 22).

Options to display the tab entries
The lists of Targets and Macros can be displayed in the following display modes:

= List: displays small symbols and the name (next to each other)
= Details: displays small symbols, the name as well as other information in the form
of a table

How to change the display modes to display the Targets or Macros:
1. Open the control panel of the Java client.
2. Open the View menu.

3. Select the List or Details menu item.
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Displaying the on-screen display via the control panel

The on-screen display (OSD) of the KVM matrix system can be dis-
played in the client window. The OSD enables you to operate and @E
configure the system.

NOTE: Since the display of the on-screen display is not created by the KVM matrix
system but by the Java client, the position and the synchronisation settings cannot
be changed!

How to display the on-screen display of the KVM matrix system in the client win-
dow:

1. Click the AdonlS button.

ADVICE: While working in the client window of a target, the OSD of the KVM
matrix system can be called by pressing Ctrl+Num (default).

Feasible action in the control panel

Closing the control panel
Close the control panel to continue your work in the software’s client window.

How to close the control panel:

1. Use the menu bar to click on Action > Close control panel.

Exiting the session

Exit the session at the KVM matrix system after you have finished your work or to
enable another user to use the IP console.

How to exit the session:

1. Open the control panel with the key combination Ctrl+ Shift (default).
2. Use the menu bar to click on Action > Exit session.

Exiting the Java client

How to exit the application at your computer:

1. Open the control panel with the key combination Ctrl+ Shift (default).

2. Use the menu bar to click on Action > Exit session.
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Switching to full screen mode of the client window

If the target provides the same display resolution as your local computer, we recom-
mend to display the client window in full screen mode.

In this mode, the client window is enlarged to full screen size so that the full screen
is available for the image of the target.

NOTE: Task bars and other operating elements on your desktop are covered by the
full screen of the client window.

It is not necessary to scroll in the client window when the full screen mode is acti-
vated.

How to switch the client window to full screen mode:

1. Open the control panel with the key combination Ctrl+ Shift (default).

2. Use the menu bar to click on Video > Full screen or press F11.

Defining the position of the status bar

The client window’s status bar can either be displayed at the window’s top (default)
or bottom.

How to define the position of the client window’s status bar:
1. Open the control panel of the software.

2. Use the menu bar to click on View > Status bar > Upper edge or View > Status bar >
Lower edge.
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Video profiles

When a target is accessed for the first time, a video profile is created and stored for
this computer.

Each video profile has an individual name. The basic structure of the names created by
the software and edited by the user has the following syntax:

= [pixels_horizontal] x [pixels_vertical] @[repetition rate_vertical]

NOTE: The Auto- string is put in front of video profiles that were created after the tar-
get was accessed for the first time and whose color values were not detected.

The EIM- string is put in front of video profiles that were created during the initial
start-up procedure of the Java client software or with the Create video profile function.

Displaying detailed information

How to call the settings of the current video profile:

1. Open the control panel with the key combination Ctrl+ Shift (default).
2. Use the menu bar to click on Video > Video settings > Edit active profile.
Changing a video profile

All data of a video profile can be edited and adjusted (image position, phase shift and
color values).

How to change the settings of the current video profile:

1. Open the control panel using the key combination Ctrl+Shift (default).
2. Use the menu bar to click on Video > Video settings > Edit active profile.
3. Change the setting(s) of the video profile (see page 18 f.).

4. Click Save to save your settings or discard your changes by clicking Cancel.
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Setting options

The user is enabled to edit the profile’s video settings. The following pages describe
the settings that are provided on the different tabs of the window.

The lower window section is identical on all tabs:

show directly | Refresh | | Cancel |

98.71KB/s | | 20fps | Close | | Save | | Undo |

The left corner displays the number of image updates per second in the client win-
dow (image frequency) as well as the data transfer rate (in kilobyte per second)
between KVM matrix system and Java client.

The following operating elements can also be found in this section:

display directly:  changes in the settings are immediately applied to the image
screen in the client window

Test: applies changes in the settings for the display screen in the client
window

Refresh: synchronizes the transmitted image of the target

Cancel: cancels changes in the settings and close window

Close: temporarily saves settings until the target is accessed again

Save: save settings

Undo: undo all changes since last saving

Defining the image width, position and size

The Image tab enables you to define the image width, the position and the size.

ADVICE: If you want this tab’s settings to be automatically determined, click on
Image position recognition.

The following requirements are necessary to execute this function reliably:

= The screen resolution of the target is lower than the resolution of the client window.

= The setting of the frames of the currently accessing target computer lie within a
gegnerated size (depending on the image resolution).
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The following settings can be individually optimised:

Image width:

Vertical
image position:

Vertical
image size:

Horizontal
image position:

Horizontal
image size:

image width (incl. back porch) in pixel

The image width is always bigger than the width of the actually visible
image section!

pixel (vertical) from which the image starts from

height of the visible image section

When adjusting the image height you can orient yourself to the usual
image resolutions (e. g. 1024 X 768).

Adjust the image height in way that no black frame remains and the image
is fully visible.

pixel (horizontal) from which the image starts from

width of the visible image section

When adjusting the image width you can orient yourself to the usual
image resolutions (e. g. 1024 X 768).

Adjust the image position in way that no black frame remains at the leff
side and the image is fully visible.

How to change the preset values:

1. Change your values in the different input fields.

It is recommended not to enter the numeric values directly at the keyboard but to
use the arrow keys.

ADVICE: If the display directly function (see page 18) is activated, you can change
the settings and, at the same time, view the result in the client window.

‘ NOTE: Click Undo to activate the default values of this tab.
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Defining color values

The Colors tab enables you to individually adjust the color values and the brightness
of the image.

ADVICE: If you want this tab’s settings to be automatically determined, click on
Image position recognition.

The following settings can be optimised:

Red: sets the color values for the color red

Green: sets the color values for the color green

Blue: sets the color values for the color blue

Synchronize Activate this option if you want to adjust the contrast. When the
color settings: color value is changed, the other two colors are adjusted as well.

If this function is deactivated (default), you can change the
weight of the single colors, for example to correct a color fault
in the image.

Brightness: adjusts the basic brightness of the image

How to change the preset values:
1. Use the slider to adjust the color values and the brightness.

It is also possible to enter the values directly to the particular input fields.

the settings and, at the same time, view the result in the client window.

ADVICE: If the display directly function (see page 18) is activated, you can change

‘ NOTE: Click Undo to activate the default values of this tab. ‘
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Adjusting the phase position

The setting of the phase position is an important setting to properly process the
video signal.

ADVICE: The Auto phase function automatically executes the phase setting.

To properly perform this function, a static image (for example of the desktop) has
to be output by the target.

This function cannot be performed if the screensaver is activated on the target!

How to change the preset phase setting:

1. Select the manually option in the Settings paragraph.

2. Adjust the value according to your needs.

ADVICE: If possible, display a vertically hatched image or an image with many
vertical lines at the target. Now, optimise the phase value to that effect that the
lines are evenly and sharply displayed.

It is recommended not to enter the numeric values directly at the keyboard but to
use the arrow keys.

ADVICE: If the display directly function (see page 18) is activated, you can change
the settings and, at the same time, view the result in the client window.

3. Optional: If desired, activate the Noise suppression option.

NOTE: Click Undo to activate the default values of this tab.
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Keyboard macros

Many users use shortcuts for a fast and efficient operation of the operating system or
the application software.

When operating the target via the IP console of the KVM matrix system, three
devices are arranged in the communication line: the target, the matrix switch and
the local computer on which the Java client is executed.

IMPORTANT: If a key combination, for example Ctrl+Alt+Delete, is pressed, the
local computer interprets this key combination which is therefore not transmitted
to the target.

Use the keyboard macros of the control panel as described in this chapter to ensure
that the key combinations are forwarded to the target.

Executing a keyboard macro

The keyboard macros can either be executed via the control panel or via the selected
key combinations that have been selected in the settings of the keyboard macro.

How to execute a keyboard macro using the control panel:
1. Open the control panel withthe key combination Ctrl+ Shift (default).
2. Click the Macros tab.

3. Double-click the macro to be executed.

Filtering macros with the help of groups

In order to quickly find a specific macro among the multitude of macros, the macros
can be grouped.

NOTE: The standard configuration provides the groups Linux, Novell, G&D Hotkeys,
SUN, VMWare, Windows and special keys.

How to limit the keyboard macros to be displayed on the Macros tab:

1. Open the control panel with the key combination Ctrl+ Shift (default).

2. Click the Macros tab.

3. Use the Macro group field to select the group whose macros are to be listed.
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Video functions

Automatically adjusting the size of the client window (AutoFit)

During each access, the automatic size adjustment adjusts the size of the client win-
dow to the target’s current resolution.

ADVICE: We recommend to set the resolution of your local computer higher than
the target’s resolution.

If the screen resolution of the target is higher than the resolution of your computer,
you can scroll the image section to be displayed within the client window (see

page 6).

How to (de)activate the AutoFit function via the Video menu:
1. Open the control panel with the key combination Ctrl+ Shift (default).

2. Use the menu bar to click on Video > AutoFit.
‘ NOTE: A marker next to the menu item indicates if this function is activated.

Refreshing the full screen content

The Refresh image function enables you to transmit the full screen content. Any image
artefacts that might appear are removed by the retransmission.

ADVICE: This function can also activated by pressing F5 if the control panel is active.

1. Open the control panel with the key combination Ctrl+ Shift (default).

2. Use the menu bar to click on Video > Video settings > Refresh image.

Resynchronizing the image

The Resynchronize image function enables you to fully transmit the full screen content
as well as to automatically recognize the phase.

How to fully synchronize the image:
1. Open the control panel withthe key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Resynchronize image.
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Automatically recognizing the phasing

The Auto phase function automatically recognizes the phasing.

How to execute the automatic phase recognition:
1. Open the control panel with the key combination Ctrl+ Shift (default).

2. Use the menu bar to click on Video > Video settings > Auto phase.

Automatically defining the color values

The Auto color adjustment function enables the automatic definition of the target’s
color values.

How to automatically define the color values:
1. Open the control panel with the key combination Ctrl+ Shift (default).

2. Use the menu bar to click on Video > Video settings > Auto color adjustment.

Automatically recognizing the image position

The Recognize image position enables the automatic recognition of the target’s image
position.

How to recognize the image position:
1. Open the control panel with the key combination Ctrl+ Shift (default).

2. Use the menu bar to click on Video > Video settings > Recognize image position.
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Mouse delay

Many operating systems provide the users with a so-called mouse acceleration.

NOTE: The mouse acceleration of the operating systems does not only evaluate the
distance the mouse is being moved but also the duration of this movement.

During “long” movements the cursor movement on the screen is accelerated.

If the mouse is accelerated on your local computer as well as on the target, the cursor
moves very fast and complicates the operation.

Activating the mouse delay

The control panel can be used to adjust the mouse delay during a session.

How to (de)activate the application of the mouse delay within a session:
1. Open the control panel with the key combination Ctrl+ Shift (default).
2. Klicken Sie im Menii auf System > Define mouse delay.

3. (De)activate the Enable mouse delay or Global mouse delay enabled options in the Mouse
delay settings window.

4. Click Save to apply your settings or discard your changes by clicking Cancel.

Configuring the acceleration value for the mouse delay

How to define the acceleration value for the mouse delay:

1. Access the target for which the acceleration value of the mouse delay is to be
changed.

2. Open the control panel with the key combination Ctrl+ Shift (default).
3. Use the menu bar to click on System > Gonfigure mouse delay.

4. Use the slider to adjust the acceleration value:

NOTE: If the mouse moves too fast on the target, move the slider to the left
(Slow). For the opposite, move the slider to the right (Fast).

5. Click Save to save your settings or discard your changes by clicking Cancel.
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Advanced functions

Session settings

Before establishing a session with the KVM matrix system, the user is enabled to
define the following settings for their session.

Language

The user interface supports several languages (German and English).
Select your desired language.

Hotkey selection
Select a key combination (default: Cirl+Shift) to call the control panel.

Operation

At IP-based KVM products, analog keyboard, video and mouse signals are digital-
ised before they are transmitted over the IP network.

Depending on the resolution and color depth of the target’s video signal, the pro-
vided bandwidth can be highly strained due to high data traffic.

NOTE: The performance might be influenced for narrow-band connections. As a
result, only a minimal bandwidth is provided for the mouse signal which compli-
cates the fluid operation of the mouse.

To reduce this effect you can use the Operation section to define how the provided
bandwidth is to be used preferably.

The following three possibilities are provided for adjustment:

vilew and oper-  The screen layout and the cursor are treated equally.
ate: This setting is recommended if a LAN connection is applied (default).

view: The screen layout is treated preferentially.

This setting is recommended if the task mainly consists of “viewing” when a
narrow-band connection is applied.

operate: The cursor is treated preferentially.

This setting is recommended if the task mainly consists of administering and
configuring the target and a fast screen layout is secondary when using a nar-
row-band connection.
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Encryption

IMPORTANT: In case sensitive data is being displayed and edited on the target,
activate the encryption of the Input and the Video channel for transmitting data via
the internet.

If the data traffic is transmitted via a secure VPN connection, the encryption is not
required.

The transmitted data between the KVM matrix system and the Java client can be
secured by applying encryption options.

The transmission of authentication data is always secured. Additionally, you can
encrypt the data of keyboard and mouse activities and of the transmitted video signal.

NOTE: Please mind that every additional encryption requires time and influences
the performance.

The following options for encryption are provided:
CTRL channel:  This channel transmits the exchanged data for the login proce-
dure at the KVM matrix system.
The data transmitted on this channel is always encrypted.

Input channel:  This channel transmits the keyboard/mouse signals to the KVM
matrix system.

If this channel is not encrypted, IP packets can be sniffed.

Encryption is optional and can lead to small performance losses due to higher
data traffic.

Video channel:  This channel transmits the target’s video signal to the
Java client.

If this channel is not encrypted, the transmitted image can be
restored by sniffed IP packets.

Encryption is optional and can lead to small performance losses due to higher
data traffic.

Bandwidth recognition

The provided bandwidth within an IP network can vary depending on the network
load. This might lead to a performance loss.

If you detect losses in the performance, it is recommended to re-execute the band-
width recognition.

How to execute the bandwidth recognition:
1. Open the control panel with the key combination Ctrl+ Shift (default).

2. Use the menu bar to click on System > Bandwidth recognition.

G&D UCON-IP-NEO - 27



Advanced functions

Displaying client/server information

The help menu can be used to read out information on the Java client and the KVM
matrix system.

How to display client/server information:

1. Open the control panel with the key combination Ctrl+ Shift (default).
2. Click Help > Info.

3. Click Client or Server to display the respective information.

4. Click Close.

Systemwide hotkeys in the client window

The following hotkeys are provided within an active client window:

Ctrl+ Shift+Mouse key releases the mouse from the active client window

Ctrl+ Shift+Num key In combination with a key of the keyboard’s keypad
you are enabled to scroll within the client window.

The paragraph Scrolling the image section on page 13
provides further information regarding this topic.
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